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Today’s Learning Objectives

» Examine innovative techniques to seamlessly
integrate data and technology between finance and
tax functions.

» Implement best practices for synergistic interactions
that drive efficiency and alignment across
departments.

» Demonstrate enhanced tax function value through
data analytics and technology.

ALIGNING DATA AND TECHNOLOGY STRATEGIES ACROSS FINANCE AND TAX



With You Today

A
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JEFF MCDONALD DIANA KONOPKA IAN COOPER

Tax Automation & Innovation Tax Automation & Innovation Finance Transformation
Managing Director Managing Director Principal and Practice Leader

jsmcdonald@bdo.com dkonopka@bdo.com icooper@bdo.com
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Agenda 3
for Today

- ALIGNING DATA AND TECHNOLOGY STRATEGIES ACROSS FINANCE AND TAX

Current Landscape of Finance and Tax Technology

The Importance of Finance and Tax Technology Alignment

Strategies for Aligning Finance and Tax Technology

Future Trends in Finance and Tax Technology

Wrap Up, Q&A, Next Steps
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Value Enablement Effectiveness Control

Finance Has the
Opportunity to
Drive Many

Dimensions of
Value

Integration / Efficiency Insight
Scalability
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Achieving Sustainable Value Requires Balance

Process

Process and workflow changes
are deployed to streamline and
automate operations and
enable efficient, consistent,
high-quality activities across
the organization.

People and Capabilities

The operating model is aligned with the
business strategy, optimizing roles while
leveraging local support teams to maximize
the human connection. People are provided
training and growth opportunities, building
individual capabilities and enabling
organizational success.

Enterprise
Value

Technology Optimization

IT strategy is aligned with and derived from
the business strategy. Technology solutions
are fit-for-purpose, with integrations and
configurations designed to automate,
eliminate redundant functionality, and
work with the business.

Information and Data

Data is engineered to be accurate,
appropriately extracted across systems, and
aggregated to enable automated reporting
and data-driven decision-making. Strong
data governance, data management, and
controls align data across functions and
protect sensitive information.

Change Management and Continuous Improvement
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TAXINNOVATION

Current Landscape of
Finance and Tax Technology

Where does your organization stand in the
process and technology continuum?

|IBDO
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Finance and Tax Process and Technology Continuum

To understand where you need to go on your journey, it’s critical to first understand where you are. Start by assessing where your tax and
finance functions are today by measuring against the below continuum.

WHERE IS YOUR ORGANIZATION RIGHT NOW? | BY YEAR-END? | FIVE YEARS FROM NOW?

ESY D) B AZ

- e-o y =
LEVEL 1 LEVEL 2 LEVEL 3 LEVEL 4 LEVEL 5 LEVEL 6

BASELINE ENHANCED INTEGRATED COLLABORATIVE COGNITIVE

» Manual Data Entry » Data Standardization  » Automated Document » FP&A and Tax » Finance Department » Predictive Modeling
» No Data Management  » Automation of Data and Workflow Department In Sync Fully Integrated with Capabilities
Strategy Entry and Routine Management » Dashboards and Business » Real-time Monitoring
» Limited Transparency Processes » Standardized Entity Analytics » Enhanced KPI and Automated Alerts
and Information » Enhanced Reporting and Chart of Account ). pata Portals Dashboards » Artificial Intelligence
Sharing Capabilities Coding > Higher-level » Business Intelligence
» Manual Consolidation  » Tax Sensitive GL > Centralized Tax Data Automation Tasks » Key Tax Figures at the
Processes Accounts Identified » Improved Information p (Cross-functional Fingertips of the
» Siloed Tax Function Storage and Sharing Collaboration Stakeholders
» Holistic View of Total
Tax Liability
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TAXINNOVATION

The Importance of Finance
and Tax Technology Alignhment

A Strategic Imperative for Streamlined
Operations and Informed Decision-Making

|IBDO
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Align Your Finance and Tax Functions
to Make Smarter Decisions, Faster By transforming your finance function,

you can take your finance department:

The demands on finance departments have become increasingly challenging to
manage. Today’s business environment is presenting new, complex factors that are
driving the need for finance department optimization, including:

» Must demonstrate ROI to the business » Voluminous and complex global tax

» Demand for greater transparency reporting requirements
and comparability » Increasing complexity in

> Reductions and constraints on tax-technical areas SILOED COLLABORATIVE
workforce/headcount » Need for speed and performance

Through a holistic focus on your process, data, technology, and people, you
can respond to these challenges and handle your finance responsibilities faster,

with more accuracy, and cost effectively. REACTIVE PROACTIVE

The Four Dimensions of Finance Department Optimization

PROCESS DATA TECHNOLOGY PEOPLE
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The Modern

F] nanCial Consolidation /
Systems Financial Reporting
|-—|_

StrUCtu re/ ERP Enablement

. N Solutions
Archltec.tu re — — -~
I llUStl’atlve MR Destination

Mgmt) Systems

The business and —> ERP/GL
technology
architecture is
standardized, Otge:tse‘r’::ce jj —
integrated, and ¥ :
automated. Management / CPM (Budgeting/

Forecasting)

Operational Reporting Solution

Denotes aspects of a Finance function
where there is a need for Tax
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Tax Requirements Within a Finance Function

A strategic, value-add tax department is one of the largest consumers of data within an organization

Finance System or Process Tax Department Impacts

ERP/GL Tax journal entries, transfer pricing, tax returns, tax provision

Transactional GL Detail Sales and use tax, general ledger detail analysis for tax sensitivity

Revenue Cube Apportionment, gross receipts taxes, foreign derived intangible income/cross-border revenue
CRM/Salesforce Customer information, Pillar Two, apportionment, state & local tax

HR/Payroll Pillar Two, apportionment, executive compensation, employees by state, state & local tax, payroll taxes
Consolidations Trial balances (local/USD), reconciliations

Management Reporting Tax impact on earnings per share

Fixed Assets Tax fixed assets

Financial Reporting Tax impact on financial statements

Intercompany Transactions Transfer pricing, Pillar Two, U.S. international calculations, state & local tax

Account Roll Forwards Tax account roll forwards, tax payments by country

Procurement Sales and use tax

Treasury Intercompany loans/intercompany transactions, transfer pricing

Bank Accounts Foreign bank and financial accounts

ALIGNING DATA AND TECHNOLOGY STRATEGIES ACROSS FINANCE AND TAX



Case Study: Reducing High-Risk, High-Cost Manual Operations

Integrated ERP and Realized Benefits
Single Data Source

» Decrease cost to
comply (audit fees,
compliance cost)

Current State

Starting Point 30-40%

» Faster close /
more time for
analysis

ERP Enhancement
and Further Automation

22,000 Manual Hours

that can be Addressed » Procurement spend

savings / cost
transparency

1 O' 1 5% Process Redesign and
Operating Model Changes

(Equivalent to

11 FTE per year) » Integrated project

tracking capability

» Drill-down cost
transparency

20-30%

Manual Work

Remaining

ALIGNING DATA AND TECHNOLOGY STRATEGIES ACROSS FINANCE AND TAX



Benefits of Alighment FOCUS ON

» Cross-Functional Collaboration

» Unified Data Management

» Automation of Key Processes
Benefits of alignment between Finance and Tax include:

]
> Improved Decision Making: Accurate financial and tax data supports ITEMS TO CONSIDER

@ informed strategic decisions. » Customization Needs: Assess

A\ 24 .
the need for customization to
meet specific tax and financial

,»q’ Scalability and Flexibility: A well-aligned system can more easily reporting requirements.

I]|][|[quu adapt to business growth and changes in tax laws. User Training and Support:

Provide training to help ensure
staff can effectively utilize the
technology’s functionalities

:ﬁg Enhanced Reporting: Integrated systems provide comprehensive
ok

o o reporting capabilities, facilitating better insights and transparency. ¢ " d A Control
ecurity and Access Controls:

Implement security measures
and access controls to protect
sensitive data and restrict
access to authorized personnel
only

o ® ‘99 Better Resource Allocation: With streamlined processes, resources
6‘9 can be allocated more effectively to strategic initiatives.
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TAXINNOVATION

Strategies for Aligning
Finance and Tax Technology

How do | manage it all?

|IBDO
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Every Tax Department Needs a Data Management Strategy
KEY BENEFITS OF ROBUST DATA MANAGEMENT

® S
EMPOWERING

» Enables tax departments
to manage and own data

» Allows tax professionals to
build meaningful reports

n ALIGNING DATA AND TECHNOLOGY STRATEGIES ACROSS FINANCE AND TAX
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CONNECTABLE
» System agnostic

» Connectible to various tax
engines and ERP systems

KPR

1

R™"HA
SCALABLE

» Data can be leveraged
throughout organization

» Can replace complex and
error-prone Excel
calculation workbooks



What is a data management strategy?

An effective data management strategy enables the tax department to seamlessly access and transform business data, automating
it for downstream use. This approach facilitates scalable solutions, analytics, and reporting for the tax department.

Defining Data Requirements

Data Governance, Security, and Retention Policies

DATA
QUALITY

Leveraging Technology & Transformation Tools Relevance Accessibility

Data Lifecycle Management

Completeness

Implementation, Change Management, and Adoption

ALIGNING DATA AND TECHNOLOGY STRATEGIES ACROSS FINANCE AND TAX



Steps to Data Strategy

ESY

g =
STEP 1
ASSESS

Describe the current
data landscape.

» Manual Data Entry

» No Data Management
Strategy

» Limited Transparency
and Information
Sharing

» Siloed Tax Function

it

STEP 2
DEFINE KPIs

Define finance function
and business goals.

» Automated Document
and Workflow
Management

» Improved Information
Storage and Sharing

» EPS, EBITDA, ETR,
Cash Tax, Etc.

W

STEP 3
IDENTIFY SOURCES

Outline all process
inputs, how they’re
stored and should be
processed.

» Data Standardization
and Location

» Automation of Data
Entry and Routine
Processes

» Enhanced Reporting
Capabilities

STEP 4

INTEGRATE
TECHNOLOGY

Understand current
technology stack and
identify new technology,
systems or processes to
implement.

» Data Lakes and
Warehouses

» Data Analytics and
Visualizations

» Artificial Intelligence

|
ilin
STEP 5

IMPLEMENT

Define a roadmap and
execute a plan set to
meet business
requirements.

» Key Milestones and
Timelines

» Resource and Budget
Considerations

» Change Management

» Process
Documentation

DATA EVOLVES, AS WILL YOUR DATA STRATEGY

STEP 6
LEVERAGE

Focus time on value-add
activities.

» Predictive Modeling
Capabilities

» Real-time Monitoring
and Automated Alerts

» Finance Delivering
ROI to the Business in
Real-time

m ALIGNING DATA AND TECHNOLOGY STRATEGIES ACROSS FINANCE AND TAX



Alignment to
Tax Function
Priorities

Managing Your
Business

Effective Tax Supporting Mitigating

a
Strategy Can: Your Workforce {:ﬁ2 Risk

» Preserve liquidity

» Lower costs Tax Strategy and
Performance
» Work in tandem Optimization

with the overall
business strategy

Evolving Regulation, ) Understanding the
Legislation and Compliance Economic Impacts
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TAXINNOVATION

Future Trends in Finance
and Tax Technology

Harnessing Innovation to Transform Finance
and Tax Operations for Enhanced Efficiency
and Strategic Growth

|IBDO
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Tax Technology and Data Evolution

Local Drives Shared Networks Tax Data Warehouse SharePoint Data Lakes
» Paper Files » Interlinked Files » Tax-only Data » Data Storage » Data Storage and
» Data Saved to Local » Complex Excel » Structured Data » Workflow Management Transformation

Drives Formulas > Retention Policies > Security > Structured and
> CDs/Disks > Retention Policies A Unstructured Data
> Fire Retention Storage > Security

of Paper Files A

A

2 -
hd
(]
(o]

. v Data Integration Artificial Intelligence

Automation > APls » Chat GPT
\4 » ETL Tools: Alteryx, > M1cro.soft Cop1l.ot
Tax Engines Microsoft Power Query > Machine Learning

Microsoft Power Bl

: gorpstax » Excel Add-ins
v ne tream » Visual Basic for
Manual > Longview Applications (VBA)
Processes » Oracle TRCS

Technology

ALIGNING DATA AND TECHNOLOGY STRATEGIES ACROSS FINANCE AND TAX



MICROSOFT AND LINKEDIN WORK TREND INDEX REPORT
Employees Want Al at Work, and Won’t Wait

for Companies to Catch Up

Réc-

ALIGNING DATA AND TECHNOLOGY STRATEGIES ACROSS FINANCE AND TAX

69?592) Three out of Four people use Al at work.
N~ Usage nearly doubled with the last six months

7 5% Of people are already using Al at work

45% Of them started using it less than 6 months ago

Survey questions:
How often to you use generative artificial intelligence for your work?
How long have you been using generative artificial intelligence at work?

2024 Work Trend Index Annual Report
from Microsoft and LinkedIn



MICROSOFT AND LINKEDIN WORK TREND INDEX REPORT
For Employees, Al Raises the Bar

and Breaks the Career Ceiling

2024 Work Trend Index Annual Report
From Microsoft and LinkedIn

Survey questions:

» To what extent do you agree or
disagree with the following
statements about generative artificial

Leaders say early-in-career talent will
get greater responsibilities due to Al

intelligence’s impact on skills?

* | would be more likely to hire a less
experienced candidate with Al skills
than a more experienced candidate
without Al skills.

* In considering job candidates, |

66%

Leaders would not hire someone
without Al skills

would not hire someone without Al
skills.

» Because they can delegate more
work to Al, early-in-career talent
will be given greater
responsibilities.

Leaders more likely to hire a less
experienced candidate with Al skills than
a more experienced one without them

ALIGNING DATA AND TECHNOLOGY STRATEGIES ACROSS FINANCE AND TAX




The Al-Powered Future of Tax

SOURCES AGGREGATION REPORTING

Automation- Tax Preliminary Review and
Assisted Source  Determination Review Sign-Off
Aggregation Engine Workbook
» Master Data i
— g”ri’ » Review
» Transaction Data g —_— ¢ —> ﬁ?} > ‘ > % _— Dashboard
» External Data Sources -— - » Filing
INTELLIGENT DIGITAL STAFF LAYER
» Automated Data Intake » Tax Regulation Research » Document Summary » Memo Generation
» Transactions and Account Mapping » To-Do Reminders » Formula Review » Financial Report
» Pattern Recognition » Information Aggregation » YOY-Based Review Generation
» Unstructured Data Transformation » Email Summary » Reconciliation » Email Draft

» Due Date Reminder

TAX DATA LAYER

T Tax Data Warehouse, Connectors to the Sources, Ability for Real-Time Analytics,
oom Dashboard-Assisted Review, Workflow-Driven Review and Approval, Collaborative Calendar and Tracker

ALIGNING DATA AND TECHNOLOGY STRATEGIES ACROSS FINANCE AND TAX



Empower
Business

Decisions

WITH END-TO-END
TAX ANALYTICS

Accelerate tax data
potential with
Microsoft Fabric

From tax data source
integration and engineering to
tax intelligence and real-time
analytics, Microsoft Fabric helps
enable tax professionals to host
all their analytics workloads in
a SaaS-based, lake-first
solution — helping to eliminate
organizational siloes and
accelerate speed to tax
insights.

THOMSON REUTERS

m Mew S0L query Ja Mew visual query

i Tax Database odel for easier reporting. To add lakehouse objects to the model, go to Man) Tax Data Transform ation

Explorer
+  Warshouses
v master_data
v B Schemas
&b dbo
« [ Tables
» Bl Adjustment_codes
» B TB_Account_name
> Bl TB_Units
» B7 Views
» B Functions
» BT Stored Procedures
guest
INFORMATIOMN_SCHEMA
gueryinsights
5y
» BD Security
~  Queries
B0 My queries

« E3 shared queries

L 4

a

Query activity

B TB_Demo_visual...

E__] Manage columns -

[ TB_Account_name

BE - &

E T8 Account_name (2]

[ T8 Units ()

BE-EF

BE - AY

‘3\/ Reduce rows.

Bsteps |

5 staps T

El Sort -

B 78 Units

| Seurce

% Transform -

["-"ﬁ] Combine ~ D.? b v Cf

% Save as view J;r View SQL

B B BE &
Choose columns  Inserted Literal  Appended guery

Merge
|@ 9

@]
| Source
@

E Dowmload Excel file [te Visualize results

Tax Data Visualization

B 123 Business Unit_Code [ = | - Susiness Unit Name = | i Profile Name [~ | & Entity Active v/mi | = | FE T8_account_name (2) [1¢]

@ TE_Deme_visual query

(-I--ERE- EY R  EPE R K]

— T—H—

200 | AU Compary
200 | AL Camnpamy
400 BR Company
E00| CA Compary
600 CM Company
700 | CM Compary
&S00 CM Company
00| C0 Company

Demo
Demao
Demeo
Dema
Demo
Demo
Dema

e
Y [Table]

-
[Table]
"

= = — —

Other
Data Sources

- -
g Excel e g g

Primary Fixed Assets
ERPs System

ONESOURCE

568599436 $12500266

$512319.409
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Putting It All Together for Tax

Sources ' Microsoft Fabric Workspace

9 Microsoft Copilot

- Data Ingestion EE] —  Transformation Deliverable

ERP & Visual Query and Data Workflows
Financial ﬁ —J Transform, import, route, automate processes

Consolidation Other: Data Wrangling Tool, Python, SQL, etc.
Pipelines o
Copy data into Fabric not > v ' utputs

Master Data already loaded or mapped
Data Storage (OneLake)
E (\ Lakehouse Lakehouse Tax (\ Lakehouse Tax 1
Data Workflows X Finance XX Provision 2= Compliance
Master Files Import and transform data » ERP » Book-Tax Differences » Data Requests and Power Bl
from a range of sources » Consolidated » Provision Calculations Requested Data
Financials (Valuation Allowances, » Specific Compliance
Discrete) Calculations (State, Net Tax
( t ) » Data Requests and Operating Losses) Software
Requested Data » Reporting and Analysis
» Reporting and Analysis » Tax Software Reports
Other Upload Tables/ » Tax Software Reports (Outputs)
Files Notebooks (Outputs)

ALIGNING DATA AND TECHNOLOGY STRATEGIES ACROSS FINANCE AND TAX



TAXINNOVATION

Wrap Up, Q&A,
Next Steps

|IBDO



In Summary

Collaborate

Finance and Tax
leaders must work
together! It’s never too
late to start
collaborating more
closely.

ALIGNING DATA AND TECHNOLOGY STRATEGIES ACROSS FINANCE AND TAX

%)

REALLY Listen to
Stakeholders

Remain laser focused
on how Finance and
Tax can contribute to
the goals of the
organization.

Level Up

It can be done. Take
steps now to push your
Finance and Tax
functions to the next
level!



Knowledge . |
Check Would you like to speak with someone at BDO about

the topics discussed in today’s webcast?

A Yes, I’d like to speak with someone about Finance Transformation

B Yes, Id like to speak with someone about Tax Transformation

C No, thank you, not at this time
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TAXINNOVATION

2025 Tax Innovation
Jo'in US for WebcaSt SerieS: A

Data-Driven Approach
the Next for Al Use Cases in Tax
Webcast!

bdo.com/events

!@ JUNE 17, 2025 4! {

2:00 PM ET
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CONTACT US »

About BDO USA

Our purpose is helping people thrive, every day. Together, we are focused on delivering exceptional and sustainable
outcomes and value for our people, our clients and our communities. BDO is proud to be an ESOP company, reflecting a
culture that puts people first. BDO professionals provide assurance, tax and advisory services for a diverse range of clients
across the U.S. and in over 160 countries through our global organization.

BDO is the brand name for the BDO network and for each of the BDO Member Firms. BDO USA, P.C., a Virginia professional
corporation, is the U.S. member of BDO International Limited, a UK company limited by guarantee, and forms part of the
international BDO network of independent member firms. For more information, please visit: www.bdo.com.

Material discussed is meant to provide general information and should not be acted on without professional advice tailored to your needs. I BDO
®

© 2025 BDO USA, P.C. All rights reserved.
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